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Java 8 New Features Introduction

Workshop Overview

¢ Intermediate level course covering the new features
introduced in Java 8

+ Coursecovers the following areas of Java 8:
— New interface capabilities
— Lambda expressions and method references
—Functional interfaces
— Java Streams
— New parallel processing capabilities and the Stream API
— New Date / Time API

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 2



Java 8 New Features

Introduction

Workshop Agenda

+ Session 1: What's New in Interfaces

¢ Session 2: Lambda Expressions

+ Session.3: Streams

& Session4: Parallel Processing and Concurrency
+ Session 5: Date and Time API

o Session 6: Other Capabilities

Notes:
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Java 8 New Features Introduction

Typographic Conventions

+ Code in the text uses a fixed-width code font, e.g.:

Catalog catalog = new CatalogImpl()

—Code fragments are the same, e.g., catalog.speakTruth()
—We bold/color text for emphasis

~Filenames and paths are in italics, e.g., Catalog.java

—Notes are indicated with a superscript number ) or a star *

—Longer code examples appear in a separate code box (below)

JButton coolButton = new JButton("Press Me for Coolness");
cooltButton.addActionListener(
(e) -> System.out.printin(''Lambda expressions are way cool")

)

Notes:

(M If we had additional information about a particular item in the slide, it wouldappear here in the notes.

¢ We might also put related information that generally pertains to.the material covered in the slide.

Copyright © LearningPatterns Inc. All rights reserved.



Java 8 New Features Introduction

Labs

¢ The workshop has numerous hands-on lab exercises,
structured as a series of labs

—Many use types from a fictional case study called JavaTunes
* An.online music store
— The lab.instructions are separate from the main manual pages

o Setup zip'files are provided with skeleton code for the labs
— Students add code focused on the topic they're working with

— There.is-a solutionzip with completed lab code

o Lab slides have an icon in the upper right corner of the slide

— The end of a lab-is marked with a stop sign

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 5
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on 1: What's New in Interfaces

Default Methods
Static Methods
Functional Interfaces

Notes:
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Java 8 New Features Session 1: What's New in Interfaces

Lesson Objectives

¢ Quick review of Java interfaces

¢ Use default methods in interfaces
— And-understand more complex inheritance scenarios

¢ Use static methods in interfaces

¢ Introduce definition of a functional interface
— These underlie many of Java 8's new features

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 7



Java 8 New Features Session 1: What's New in Interfaces

Interfaces — Quick Review

o Java interfaces specify a type that is (mostly) separate from
any implementation

— Often used to define roles played by an object

¢ An interface defines a type that is similar to a class — with
some key differences:
—Can declare methods, but these methods are abstract

» Except for Java 8 default methods and static methods
(covered next)

— Can also have properties, but all properties are static final
constants

— Cannot be instantiated with.the new keyword

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 8



Java 8 New Features Session 1: What's New in Interfaces

Interfaces — Example

+ Regular interface methods are declared without a body
— Implicitly abstract, with no implementation, as shown below

¢ To implement an interface, you write a class with
implementations for all the interface methods

= If you don't implement all the methods, your implementation
class must be declared as an abstract class

pubTlic dnterface Moveable {
public void moveTo(String dest);
3

public class PosterTube implements Moveable {
// provides an dimplemented moveTo(String) method
public void moveTo(String dest) {
// implementation-here

}

}

Notes:

+ Like classes, interfaces can be placed in packages.

— Like classes, interfaces are either publ1ic or not. public interfaces are visible to classes in
other packages, whereas non-pub1ic interfaces are visible only within the same package.

* In practice, most interfaces are declared to be pub1ic.

+ Interface methods are inherently publ1ic and abstract.

— In practice, the pub1ic keyword is used, but the abstract keyword 1s omitted.

Copyright © LearningPatterns Inc. All rights reserved. 9



Java 8 New Features Session 1: What's New in Interfaces
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Default Methods

Default Methods
Static Methods
l Functional Interfaces

Notes:
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Java 8 New Features Session 1: What's New in Interfaces

Default Methods

+ Default methods provide implementations in interface itself

— Default methods are not abstract, and implementing classes
don't need to implement them

¢ But'may override them with their own implementation

¢ Below, we addgetCurrentLocation() to Moveable

< defaul t keyword and provided implementation (in { })
indicate itis a default method

public interface Moveable {
public void. moveTo(String dest);

default public Location getCurrentLocation() {
// return GPS-based Tocation - details not shown
¥
}

Notes:

¢ The details of the Location type, and the implementation of getCurrentkocation() are not relevant
to how default methods work.

& Implementing classes only need to provide an implemented moveTo () method.
— Optionally, they can also provide an implemented getCurrentlocation() method.

— If they don't, the default implementation will be used.

& The default keyword does not need to appear first, though you'll usually find‘it- written this way, for
clarity. Our default method above could also be written as:

public default Location getCurrentLocation() { ... }

Copyright © LearningPatterns Inc. All rights reserved. 1



Java 8 New Features Session 1: What's New in Interfaces

Default Methods - Example

+ Below, Car implements Moveable
— It provides an implemented moveTo () method
— It inherits the default getCurrentLocation() method

public class Car implements Moveable {
public void moveTo(String dest) {
// implementation here
:
}

class GetMoving {
public static voidemain(String[] args) {
Moveable my= new Car(Q);
m.moveTo("Seattle"); // Car's 1impl
System.out.printin(m.getCurrentLocation()); // default impl
ks
3

Notes:

+ Because Car implements Moveabe, it can be referenced as type Moveable.  A.Car IS-A Moveable.

— Sometimes you'll see this written as above, sometimes you'll see this as a parameter type:
public void ship(Moveable item) { // a Car can be passed in

) .

Copyright © LearningPatterns Inc. All rights reserved.
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Java 8 New Features Session 1: What's New in Interfaces

Motivation and Benefits of Default Methods

¢ Provide a common implementation for reuse
— Implementing classes can inherit and use the functionality

— For example, interface java.lang.Iterable defines a default
forkach () method ™

* Inherited by java.util.Collection, and all implementing classes
» Works easily with lambda expressions, covered later

+ Allows easy evolution of interfaces
— Wheniadding a new default method, existing implementations
continue working unchanged
« Binary compatibility is maintained
— Adding a "regular" (abstract) interface method requires an
implementation in.all implementing classes
 Breaks all existing implementation classes! (bad bad bad) ?

Notes:

() Iterable.forEach() performs an action on each element in a collection.
— The method supports lambda expressions, covered later.
— The action can be defined and passed in at the point of call, using a lambda expression.

— We'll cover collections and lambda expressions later.

2) Remember that all "regular" methods in an interface are implicitly abstract.
— An implementing class must implement them, or the class itself must be.declared abstract.
— If we add a new, non-default method to an interface, binary compatibility is not maintained.

* Your implementation class (which formerly compiled fine), is now flagged with compiler
errors, because it doesn't implement the new method.

— If we add the new method as a default method instead, the method is available to be called, even
for implementation classes written to the old interface definition.

* The default implementation is inherited, and is used as needed.

» No existing code is broken.

Copyright © LearningPatterns Inc. All rights reserved. 13



Java 8 New Features Session 1: What's New in Interfaces

Motivation and Benefits of Default Methods

¢ Reduced need for adapter classes defining "empty" methods
— Common before default methods (see notes)
— Interfaces can now define default (or empty) implementations

o Enhances Collections API to support lambda expressions
— Covered later

+ NOTE: can't define Object methods like equals() as a
default method ()

Notes:

+ "Interface adapter" classes are sometimes used in situations where a "large' interface is required, but
in many uses cases, only one or a few of these methods is important.

— Well-known example is the Java AWT WindowL1istener interface and accompanying
WindowAdapter class.

WindowListener is an interface with 7 abstract methods;a "large" interface.
WindowAdapter is an implementing class with 7 empty methods, i.e., { }. =olx]

* You can subclass WindowAdapter and override only the methods.you care about, and then
use your subclass as a WindowListener. For example, to get the "X" button to respond by
terminating the application, you need to pass a WindowL1istener to the Ul window's
addwindowListener() method. The applicable WindowListener method is
windowClosing(WindowEvent). Often, you don't care about the other 6 methods in
WindowListener. In this case, you can subclass WindowAdapter and override only the
windowClosing() method (you inherit the other 6 empty methods).

¢ With default methods in interfaces, the WindowAdapter class wouldn't be necessary.

— You could just write a WindowListener implementation class with a single windowClosing()
method. Your implementing class inherits the other 6 default methods.

— For the record, WindowListener was not enhanced to supply default methods in Java 8.
(1) See : http://mail.openjdk.java.net/pipermail/lambda-dev/2013-March/008435.html

Copyright © LearningPatterns Inc. All rights reserved. 14
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New Features Session 1: What's New in Interfaces

4

Inheritance Issues

Situation: a class implements two interfaces, each with the
same default method signature (return type is not considered)

public interface Moveable {
public void moveTo(String dest);
default public Location getCurrentLocation() {
// impl1
3

by

pub1ic)interface Item {
public -doubTe getWeight();
default public Location getCurrentLocation() {

// impl 2
3
}
public class Car implements Moveable, Item {
public void moveTo(String dest) { ... }
public double getWeight() { ...}

// Q: which getCurrentLocation() method do I get??? (see notes)
}

Notes:

# A: neither! Compile-time error.

Since we have an ambiguity, the class must explicitly‘provide an implemented
getCurrentLocation() method.

& Related, what happens if interface Beta extends interface ATpha, both of which define' a default
method named doIt()?

1. Class A implements Alpha.

2. Class B implements Beta.

* Ineach case (1) and (2) above, what happens in A and B with respect to the doIt() method?

* Hint: use your gut instinct — it does what you expect it to.

Copyright © LearningPatterns Inc. All rights reserved.
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Static Methods

Default Methods
Static Methods
l Functional Interfaces

Notes:
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Java 8 New Features Session 1: What's New in Interfaces

Static Methods

o Static methods now legal in interfaces
— Recall that static methods are associated with a type
— Static methods in an interface work the same way as in a class

o Supposea Location interface was defined as below

~.getNorthPole() is a "factory method" of Location, which
returns a_Location object

— Factory methods are often static, and they can now be
members of an interface

pubTlic interface Location {
static public Location getNorthPole() {
// return an{instance of some class that implements Location
¥
3

client code:
Location northPole = Location.getNorthPole();

Notes:

& Asusual, static methods are called as Type.methodName (), €.g., LocationugetNorthPole() in the
example above.

¢ The static keyword does not need to appear first, though you'll usually find it written this way, for
clarity. Our static method above could also be written as:

public static Location getNorthPole() { ... }

Copyright © LearningPatterns Inc. All rights reserved. 17



Java 8 New Features Session 1: What's New in Interfaces

Benefits of Static Methods

+ Useful for utility methods and functions, e.g., those found in
the Collections class and Math class

— Reducing need for separate utility classes

¢ No need for separate "factory class"
= The interface type serves as its own factory for instances ()

¢ NOTES:
— Implementing classes can't override them
« Just like subclasses can't, either

— Can't define Object methods like equals() as a static
method

 Classes can't do this, either
— Basically, all the normal-rules apply

Notes:

(M We'll see the Comparator interface a lot in this course.: The Java 8 Comparator interface has added
several new static methods that return an instance of Comparator, obviating the need for something
like a ComparatorFactory class.

— You can thus get Comparator instances by using only thednterface type.
Comparator c = Comparator.comparing(...);
Comparator c = Comparator.reverseOrder();

Copyright © LearningPatterns Inc. All rights reserved. 18
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Functional Interfaces

Default Methods
Static Methods
l Functional Interfaces

Notes:
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Java 8 New Features Session 1: What's New in Interfaces

Functional Interface — Defined

¢ An interface that defines exactly one abstract method
— Simple concept, but vitally important for lambda expressions
— Used extensively later — just introducing the concept now

¢ @QFunctionalInterface can be used to indicate a functional
interface
— Not required — only requirement is that interface define exactly
one abstract method

— If youuse @FunctionalInterface on an interface that is not
one, the coampiler will-flag it as an error

@FunctionalInterface. // optional, just gives a compile-time check
pubTlic interface ActionlListener extends EventListener {
public void actionPerformed(ActionEvent e);

}

Notes:

¢ The ActionListener interface has only one abstract method — actionPerformed().

— Therefore, it is a functional interface.

¢ In our example, we annotated ActionListener with @FunctionalInterface. However, that is not
required.

— The @FunctionalInterface annotation is not actually present in the.definition of
ActionListener in the Java library — we include it only for illustration.<If, however, weput it
on an interface that had zero or 2+ abstract methods, it would generate.a compile-time error.

— For example, the interface definition below results in a compilation error:

@FunctionalInterface
public interface MyInterface {
pubTic void myMethodl();
pubTic void myMethod2();
}
# Using @FunctionalInterface is a good idea, as it documents that this is a functional interface,
plus it gives you the compile-time check.

— Without it, the readers of your code would have to search through the methods, counting up the
abstract ones to determine if it's a functional interface.

Copyright © LearningPatterns Inc. All rights reserved. 20



Java 8 New Features Session 1: What's New in Interfaces

Functional Interfaces — Details

& Sometimes referred to as "SMI" or "SAM" types
— SMI: Single Method Interface
— SAM: Single Abstract Method

o NOTES:

— Default and static methods do not count toward the "exactly
one abstract method" rule

— Nor.do abstract methods defined in Object (see notes)

Notes:

& From the Javadoc for @FunctionalInterface:

— An informative annotation type used to indicate that an interface type declaration is intended to be a
functional interface as defined by the Java Language Specification. Conceptually, a functional interface
has exactly one abstract method. Since default methods have.an’implementation, they are not abstract. If
an interface declares an abstract method overriding one of the public methods of java.lang.0Object, that
also does not count toward the interface's abstract method count since any implementation of the interface
will have an implementation from java.lang.0Object or elsewhere.

Copyright © LearningPatterns Inc. All rights reserved. 21



Java 8 New Features Session 1: What's New in Interfaces

Case Study - Comparator

¢ java.util.Comparator is a well-known interface
— Often used for sorting a collection, e.g., a List, via this method:
void sort(Comparator<E> c)
— It's also a functional interface — int compare(E objl, E obj2)

+ See Javadoc for Comparator — google "Comparator Javadoc"

— Look at the Java 7 version first

» The equals () method does not count toward its abstract method count
(see previous page)

1

1

}

i

i — Then look at the Java8 version (wow!)
! * Is the Java 8 version still a functional interface? ()

i * Note the many default and static methods that have been added
}

1

1

1

Notes:
() When looking over the Java 8 Comparator API doc; you will probably agree that the
@FunctionalInterface annotation can be really useful:

— Because this interface is marked with @FunctionalInterface, we don't need to.scroll down at
all and count the number of abstract methods, making sure the sum is exactly 1.

— The presence of this annotation immediately answers the question, "Is the Java 8 version still a
functional interface?"

» Even though they added many more methods to it — you'll notice that these new methods are
all default or static interface methods.

Copyright © LearningPatterns Inc. All rights reserved. 22
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Java 8 New Features

Session 1: What's New in Interfaces

—

Review Questions

. An interface may have at most one default method. [T/F]
<A default method in an interface can call other methods in the same

interface. [T/F]

. Explain how default methods help interfaces to evolve "cleanly," i.e.,

without breaking existing code.

. Functional.interfaces must include the @FunctionalInterface

annotation. [T/F]

. The.Comparator interface has 2 abstract methods, yet it's a functional

interface. Explain.

. A static’interface method can only return an instance of that interface type,

e.g., Shape.get () must have Shape as its return type. [T/F]

. What's wrong with the interface below?

public interface TaxPayer {
public void register();
public double payTaxes() {
return 0.0;
ks
}

Notes:

Copyright © LearningPatterns Inc. All rights reserved.
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Notes:

& Version 20160311
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Labs: Java 8 New Features Introduction

Release Level

+ This manual contains instructions for creating and running the Java
8 New Features labs using the following software packages:

— Java 8 SDK
— Eclipse Java EE - Luna (4.4) or later

+ The labs have been tested on Eclipse Luna/4.4 and Mars/4.5
— LLuna or later is required for Java 8 support

Notes:

# The instructions for the labs are geared for Eclipse Luna/4.4 or later.

— Java 8 support is required, which is available in Eclipse’4.4+. Java 8 support can be added to
previous versions of Eclipse, e.g., Kepler/4.3, with the-addition of a patch.

Copyright © LearningPatterns Inc. All rights reserved. 2



Labs: Java 8 New Features Introduction

A Word about JUnit

o Our labs and some examples use JUnit to run program code
— JUnit is a popular open source Java testing framework

+ JUnit tests have the following characteristics:
— Annotate test methods with @Test
— Make assertions using static methods in org. junit.Assert
='We show an example below

import.static org.junit.Assert.*; // see notes on static imports
import org.junit.Test;

public class ArrayTest {
@Test
public void testArraylLength() {
int[] intArray-'= {1, 2, 3, 4};
assertTrue('"length _ should 'be 4", 1intArray.length == 4);
¥
ks

Notes:

¢ The assertXXX() methods are all static methods of Assert.

— The familiar way to use these methods would be to‘import org. junit.Assert, and then call the
static methods through the Assert class.

Assert.assertTrue(collection.isEmpty());

— This is a little cumbersome, so the static import feature of Java is used — which importsstatic
members from a class.

— The following import statement imports all the static members (including methods) from the
Assert class:

import static org.junit.Assert.*;
— This allows us to use the static members without qualifying them by the classname:
assertTrue(collection.isEmpty());

& There is much more capability in JUnit.
— We won't go into that, since it's beyond the scope of the course.

— We only cover enough to show how the labs work.

Copyright © LearningPatterns Inc. All rights reserved.



Labs: Java 8 New Features Introduction

Test Cases in the Labs

+ JUnit is a convenient driver for our lab code
— Italso lets us easily test our results

+ In the labs; we'll generally give you the test class
— Sometimes the tests are already written
— Sometimes you'll need to add test code

+ Note.in the previous example how testArraylLength() is
annotated with @Test
— It creates an array, then checks the length
— We use assertTrue() to perform the test
» This is a static method of Assert

* We use a static-import for convenience — see notes previous page for
details

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 4
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.1: Setup, Default Methods,
/Static Methods

In.this lab, we'll set up our lab environment, then work
with default and.static interface methods

Notes:

Copyright © LearningPatterns Inc. All rights reserved. 5



Labs: Java 8 New Features Lab 1.1: Setup, Default Methods, Static Methods

Lab Synopsis

¢ Overview:
— Set up our lab environment and the Eclipse IDE

— Add default methods and static methods to an existing interface

» You'llfirst add a method as a regular (abstract) interface method, and see
what happens — then you will change it to a default method

— The types will be simple types based on a Volume interface that allows
control of a device's volume

+ Builds on previous labs: none

+ Approximate time: 20-30 minutes

Notes:
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The Eclipse Platform

+ Eclipse (www.eclipse.org) is an open source platform for building
integrated development environments (IDEs)

—Used mainly for Java development — can be extended via plugins and
used in other areas (e.g., C# programming)

¢ Originally developed by IBM
~ Released into open source
— IBM's RAD product line is built on top of Eclipse

+ Eclipse products have two fundamental layers:

— Workspace: files, packages, projects, resource connections,
configuration-properties

— Workbench: editors, views, and perspectives

o We will set up the workspace and workbench, then do our lab

Notes:

& The workbench sits on top of the workspace and provides visual artifacts thatallow you to access and
manipulate various aspects of the underlying workspace tesources.
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Information Content and Task Content

+ In a lab, information-only content is presented the same as in the
student manual pages

— Like the bullets here

& Tasks for students are in a box like the one below

Tasks to Perform
+ Note-the different look of this box as compared to that above
— All future labs will use this format

o Make surethat yourhave Java 8 or later installed
— Likely in a directory such.as C:\Program Files\Java\jdk1.8.0_51

— If not, you'll need-to install it — it can be downloaded from:
» oracle.com/technetwork/java/javase/downloads

+ OK — now get out your:setup files, we're ready to start working

___________________________________________________________________

Notes:

# The setup files may be on your workstation, or they may_be provided by yourinstructor.
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Extract the Lab Setup Zip File

+ To set up the labs, you'll need the course setup zip file
— It has a name like: LabSetup_Java8New_yyyyMMdd.zip

+ Our baseworking directory for this course will be
C:\StudentWork\JNew

— Gets created when we extract the lab setup zip

= Includes a directory structure and files (Java source files and others)
that will be needed in the labs

— All instructions assume that this zip file is extracted to C:\
If you choose a different directory, please adjust accordingly

Tasks to Perform
+ Unzip the lab setupfile to C: \

— Creates the StudentWork/JNew directory structure, containing files that
you will need for doing the labs
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Getting Started with Eclipse

Tasks to Perform

i 7 N\
Lﬂ Work“_v.pac\e Launcher

Select a workspace

Eclipse stores your projects in a folder called @ workspace,
Choose a workspace folder to use for this session,

i + Make sure you have Eclipse installed — likely in C:\eclipse
i —If not, you'll need to install it — see instructions in notes

E + Launch Eclipse: go to C:\eclipse and run eclipse.exe

i — A dialog-box should appear prompting for a workspace location
i — Set the workspace location to C:\StudentWork\JNew\workspace
: —'If a different default workspace location is set, change it

Wo rkgpa& CStudentWork\  New'\workspace >

- Browse...

[T] Use this as the default and do motask again

QK

I

Cancel

Notes:

o If Eclipse was installed elsewhere, adjust the path to'the Eclipse executable‘aceordingly.

& You can also put a shortcut on your desktop to start Eclipse.

# If you need to download Eclipse, go to http://www.eclipse.org/downloads.

— In the Package Solutions section, click on the link for the Eclipse IDE for Java EE

Developers.

— Save the zip file to your computer, and unzip it. The easiest location to unzip it to is C:|, but
another location is fine as long as you can get to it to run the eclipse.exe executable.
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Tasks to Perform
+ Close the Welcome screen (click the X on its tab — see notes)
¢ Open a Java Perspective
— Click the Perspective icon at the top right of the Workbench
— Select Java (as shown below)
— The Java EE perspective is the default for the Eclipse Java EE version

+ Close the Java EE perspective by right clicking its icon, and
selecting close (as:shown below right)

% Debug - = | . Java EE [ Java
Lo/ Git |_| Task ;¢
%’Java )
| io” Java Browsing

Workbench and Java Perspective

Notes:

¢ To close the Welcome screen, click the X in the tab, as 'shown below.

o The Eclipse Java EE version opens in the Java EE perspective by default.

File " Edit. Mavigate 3earch’ Project

=
i
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Tasks to Perform
¢ Unclutter the Java perspective by closing some views
— Close the Task List and Outline views (click on the X)
— You can save these changes to the perspective (see notes)

Flle Edit) Source Refactor MNavigate Search Project Run Run  Window Help

- i o @ v|‘@\|#¢§ DRSSl H=Rl g N SR S
1 Quick Access ﬁl 7% Java EE

IIE Package Explo = 0

E==>|.

[2i Problems 7 @
0 items

Description

Unclutter the Workbench

Notes:

# Save these changes to the Java perspective via Window > Save Perspective As > Java.

# You can reset the perspective to it defaults via Window > Reset Perspective.
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Create New Java Project

Create a Java Project

Tasks to Perform

¢ Create a new Java project
— File > New > Java Project

Create a Java project in the workspace or in an external location.|

[Eroject name: | Lab01.1 ]

¥ Use default location

* Name |t exactlx Lab01 _1 (1) Locatior{: | C:\StudentWork\INew\workspace\Lab01.1 ]
— When you name the project THE
Lab01 _1’ it will be stored in (& Use am execution enyironment JRE: JavaSE-1.8

. And |t WI" ple Up some starter | Wse defaull: IRE (eurrenthy Gak1.8,0_517%
code provided in that directory ()

FProject layout

— Make sure "Create separate
folders for sources and class
files" is selected

* May be preselectedbut grayed
out — that's OK

| Wse project folder as root: for seunces and class files

(@ Create separate folders for sources and class files ] f

B e e

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
workspace\Lab01.1 : € | Use aproject spedific JRE: jdk1.8.0_51
1
1
1
1
1
1
1
1
1
1
I
1
1
1
1
I
1
1
1
1

..
1
1
1
1
1
1
1
1
}
1
1
}
1
1
1
1
1
1
1
1
1
1
1
1
}
1
1
1
1
I
1
1
1
.

Notes:

() IMPORTANT NOTE: you must name the project Lab01.1, in order to pickup the starter code
provided in the lab setup. That's because the starter code ' was preprovisioned in the
workspace/Lab01.1 directory (in appropriate subdirectories).

— By naming the project Lab01.1, the project directory defaults to workspace/Lab01.1, and the
starter code is automatically recognized and included in the project's fileset.

& There are multiple ways to create a new project.
— File > New - Project > Java > Java Project.
— Click on the "New" wizard icon in left side of the toolbar.

— Right click in the Package Explorer view, select New ...

# It's usually better to create separate folders for source and class files.

— We've done that here, and Eclipse puts the .java files in the lab's src directory, and the .class files
in the lab's bin directory.

— This is the default structure for Java projects in Eclipse.
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Tasks to Perform

¢ In the next dialog (Java
Settings) click Libraries tab

+ Click the Add Library button

— In the list that comes up, i
select JUnit,;and click Next !
— Select the JUnit 4 library
and-click Finish !

¢ Back in the main wizard,
click Finish to create the
project

¢ See notes

Add JUnit to Build Path

JARs and class folders on the build path:
. = JRE System Library [jrel 8.0_45]

Add JARs...

Add External JARs,

Add Variable...

C AddLibrary...

\
\
\
l

J2ZEE1 4 libraries
Java EE 5 libraries

JUnit Library
Select the JUnit version to use in this project.

JUnitIibrar}rversi@nital D

Ll A : T 1 L L U

Notes:

+ If you ever forget to add JUnit during initial project Creation, it can also be'added later.
— In Eclipse, right-click on project directory and choose Build Path> Add Libraries > JUnit >

JUnit 4.
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*

New Project with Starter Code

The lab setup pre-provisioned some starter
code in the workspace/Lab01.1 directory

— By naming the project Lab01.1, the root
project directory becomes workspace/Lab01.1

— Eclipse sees the src and test directories there,
and imports these files into the project

» We will use this technique several more times

when creating new projects in the labs

[Z Package Explorer i3 =
==
SRS ab01.1
(% src
=-H3 com.entertainment
----- [J] Radio.java

- [J] Television.java
) Volume.java
B test
Ié---EE com.entertainment

) InterfaceMethodsTest.java
-2 JRE System Library [jdk1.8.0_5
=z JUnit 4

1]

can rename it.if you'wish

— Perhaps something to indicate its purpose, e.g.,
Lab01.1_InterfaceMethods

+ Once you've created the project and you see the starter code, you

— Rename it by pressing F2 on the project folder in Eclipse, or

right-click > Refactor > Rename

Notes:
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*
2

4

¢

L 2

The Lab Types

Volume: interface that declares volume-control methods
Television: class that implements Volume

— Also has brand property (string), and some validation code
Radio: class that implements Volume

— Doesn't have much else in it
Above types in are package com.entertainment

InterfaceMethodsTest: JUnit test case
— Also in‘package com.entertainment

public interface Volume {
public void setVolume(int volume);
public int getVolume();
pubTlic void mute();
public boolean 1isMuted();

Notes:
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Lab 1.1: Setup, Default Methods, Static Methods

: ¢« Change silence () to be a default method

Add Default Interface Method

Tasks to Perform

¢ Open interface com.entertainment.Volume

—Add a "regular" (abstract) interface method with the signature below:
public void silence();
— Look in the Problems view, there should be errors
. Telewvision and Radio don'timplement this method

— Set the volume to zero by calling setVolume (0)
+ This is.a simplerform of muting — we don't save the old volume for unmute
— Your errors should now disappear

¢ Open com.entertainment.InterfaceMethodsTest

— Review the code
— In testDefaul tMethods (), uncomment call to siTence() in the loop

Copyright © LearningPatterns Inc. All rights reserved.
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Lab 1.1: Setup, Default Methods, Static Methods

Tasks to Perform

Run Your Tests

B e i e

¢ We use Eclipse to run the tests

+ In Package Explorer, right-click
on InterfaceMethodsTest

— Run As > JUnit Test

=~ Automatically finds and runs
its test methods

=& Lab01.1
B src

..... M

- test

[Z Package Explorer 2

é---aa com.entertainment

------ [ Television.java
------ [J] Volume.java

Fl!---EE com.entertainment

Radio.java

Validat

w1 1 Run on Server

4XXR

|

]
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Test Output

+ You should see JUnit output in a JUnit view, as shown below
— All tests should pass ()
—If your test produced output to stdout, it would be in the Console view

+ Note: you'll.follow similar procedures whenever you have a JUnit
test client to run in the labs

] H | & O
% Package Explorer g gUnit &3 B ol @i i"&‘- sl
Finished after 0.016 seconds
Runs: 1/1 H Errors: 0 H Failures: 0

W
O. F A
¥ it com.entertainment.testnterfaceMethodsTest [Runner: |Unit 4] (0.000 s)
re testDefaultMethods (@000 s)

Notes:

(M If you see any errors in the JUnit view, or exceptions in the Console view, then you've got something
configured incorrectly.

2> When running programs in other labs, the only thing that may change is the program class that you'll
need to right click on to run.

— The general procedure will remain the same.
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Add Static Interface Method and Test

Tasks to Perform

¢ Open interface com.entertainment.Volume

—Add a static method, silenceAll() that takes a varargs Volume
argument, as shown below:
void silenceAll(Volume... vols)
* The method should loop through its arguments and silence each one
+ See notes for working with the vols parameter

¢ In your JUnit testclass:

— Uncomment the @Test annotation on testStaticMethods (), as well
as the calltosilenceAl 1)

— Run the test case again — it should run with no failures

+ You can see that these new interface-additions are easy
to work with

Notes:

() An incoming varargs argument can be treated like an array — in fact, internally, it's converted to one.

— You can iterate over it as you would with any other artay, here using a for-each loop:
for (Volume vol : vols) {

,
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